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Training on the Job - Gestione Database
e Pubblicazione Geospaziale con
PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell’Infrastruttura DB
Obbettivi:

= Comprendere la struttura logica dei dati

= Delinire e entita, frelationl & attrbts

= Produrre un diagramma E/R coerente con i requisiti del progetto

® Redigere specifiche tecniche per la realizzazione fisica del database

Attivith prewiste:
1. Analisi dei requisiti inlarmatii del progeis
2. ldentificanione delle entith princepali (es. aree verd], aree blu, poligono per
popolarione, ingrewdl per ares)
3. Definazione delle rela . LAY ANEA PO BVere molll ingress)
4. Rapprosentazione EfR con strumenti visuali (o5, draw,ig)
5. Produsions di ung sthema relazionabe
& Redazione defle specifiche tecniche con:
@ Tipd i dalo
@ Chiawi primane ed esterne
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Training on the Job - Gestione Database
e Pubblicazione Geospaziale con
PostGIS e GeoServer
1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'infrastruttura DB
Obiettivi:
= Comprendere la struttura logica del datl
= Definire [ entita, relazioni e attributi
= Produrre un diagramma E/R coerente con | requisiti del progette
= Redigere specifiche tecniche per |la realizzazione fisica del database
Aftivita previste:
1. Analisi del requisiti informativi del progetto
2. identificazions delle entita principali (es. aree verdi, ares biu, poligono per
popolaficne, INGressi per anse]
3. Definizione delle relaziond (es. un'area pud avere molti Ingressi)
4. Rappresentanones E/R con strumentt viswall [es |_'_¢_r.'|'!.:|._'.u;_.'+
5. Produzione di uno schema relazionale
6. Redarione delle specifiche tecniche con
o Tipi di dato .
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Training on the Job - Gestione Database
e Pubblicazione Geospaziale con

PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'Infrastruttura DB
Obiettivi:

* Comprendere la struttura logica dei dati

= Definire le entita, relazioni e attributi

* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:

1. Analisi dei reguisiti informativi del progetto
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1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'infrastruttura DB
Obiettivi:

= Comprendere la struttura logica dei dati

» Definire le entita, relazioni e attributi

* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:
1. Analisi dei requisiti informativi del progetto

2. Identificazione delle entita principali (es. aree verdi, aree blu, poligono per
popolazione, ingressi per aree)

3. Definizione delle relazioni (es. unarea puo avere molti ingressi)

4. Rappresentazione E/R con strumenti visuali (es. draw.io)
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PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'Infrastruttura DB
Obiettivi:

» Comprendere la struttura logica dei dati

= Definire le entita, relazioni e attributi

* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:
1. Analisi dei requisiti informativi del progetto

2. ldentificazione delle entita principali {es, aree verdi, aree blu, poligono per
popolazione, ingressi per aree)

3. Definizione delle relazioni (es. unarea puo avere molti ingressi)
4. Rappresentazione E/R con strumenti visuali (es. draw.io)
5. Produzione di uno schema refazionale
€. Redazione delle specifiche tecniche con:
o Tipi di dato

o Chiavi primarie ed esterne
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1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'infrastruttura DB
Obiettivi:

* Comprendere |a struttura logica dei dati

= Definire le entita, relazioni e attributi

* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:
1. Analisi dei requisiti informativi del progetto
2. Identificazione delle entita principali {es. aree verdi, aree blu, poligono per
popolazione, ingressi per aree)
3. Definizione delle relazioni (es. un’area pud avere molti ingressi)
4. Rappresentazione E/R con strumenti visuali (es. draw.io)
5. Produzione di uno schema relazionale
6. Redazione delle specifiche tecniche con:
o Tipi di dato
o Chiavi primarie ed esterne

o Vincoli di integrita
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# Definire le entita, relazioni e attributi
* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:
1. Analisi dei requisiti informativi del progetto
2. ldentificazione delle entita principali (es. aree verdi, aree blu, poligono per
popolazione, ingressi per aree)
3. Definizione delle relazioni (es. un'area pué avere molti ingressi)
4. Rappresentazione E/R con strumenti visuali (es. draw.io)
5. Produzione di uno schema relazionale
b. Redazione delle specifiche tecniche con:
o Tipi di dato
o Chiavi primarie ed esterne

o Vincoli di integrita

2. Installazione di Postgres e PostGIS, Setup dell’Ambiente di Lavoro e
Creazione Tabelle
Obiettivi:

» Installare PostgreSaL e PostGIs

* Configurare un ambiente di lavoro
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Attivita previste:

1. Analisi dei requisiti informativi del progetto

2. Identificazione delle entita principali (es. aree verdi, aree blu, poligono per

popolazione, ingressi per aree)

3. Definizione delle relazioni (es. un'area pud avere molti ingressi)

4. Rappresentazione E/R con strumenti visuali (es. draw.io)

5. Produzione di uno schema relazionale
b. Redazione delle specifiche tecniche con:
o Tipi di dato
o Chiavi primarie ed esterne

o Vincoli di integrita

2. Installazione di Postgres e PostGIS, Setup dell’Ambiente di Lavoro e

Creazione Tabelle
Obiettivi:

- R E |8l o A &

* Installare PostgreSOL e PostGIS
= Configurare un ambiente di lavoro
» Creare lo schema di tabelle secondo specifiche

» Eseguire un test funzionale
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2. Installazione di Postgres e PostGIS, Setup dell'Ambiente di Lavoro e

Creazione Tabelle
Obiettivi:

» Installare PostgreSQL e PostGIS
» Configurare un ambiente di lavoro

» Creare lo schema di tabelle secondo specifiche

s Eseguire un test funzionale

Fasi Operative:

2.1 Installazione PostgreSQL + PostGIS:

* Scaricare da https://www.postgresql.org

= Installazione guidata (con StackBuilder per estensioni)
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Fasi Operative:
2.1 Installazione PostgreSQL + PostGIS:
= Scaricare da https://www.postgresql.org
» [nstallazione guidata (con StackBuilder per estensioni)
» Mostrare 'utilizzo dell’applicazione pgAdmin per I'interfaccia grafica del db

» Installare "'estensione PostGl5 tramite StackBuilder ( oppure tramite terminale

2.2 Configurazione Ambiente di Lavore:

» Creazione database progetto ISPRA sia tramite pgAdmin sia tramite terminale
Postgres [ CREATE DATABASE progetto_ISPRA)

« Attivazione di PostGIS sul nuovo database

2.3 Creazione Tabelle:
» Creazione tabelle tramite pgAdmin esempio
» Creazione tabelle tramite script SQL derivati dallo schema relazionale:
CREATE TABLE poligono_popolazione (
Id_poligono SERIAL PRIMARY KEY,
geom GEOMETRY(Polygon, 4326),

Enlasl [pra
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» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:
1. Analisi dei requisiti informativi del progetto
2. Identificazione delle entita principali (es. aree verdi, aree blu, poligono per
popolazione, ingressi per aree)
3. Definizione delle relazioni (es. un’area puo avere molti ingressi)
4. Rappresentazione E/R con strumenti visuali (es. draw.io)
5. Produzione di uno schema relazionale
6. Redazione delle specifiche tecniche con:
o Tipi di dato
o Chiavi primarie ed esterne

o Vincoli di integrita

2. Installazione di Postgres e PostGIS, Setup dell’Ambiente di Lavoro e

Creazione Tabelle
Obiettivi:

* Installare PostgreSQOL e PostGIS
= Configurare un ambiente di lavoro
= Creare lo schema di tabelle secondo specifiche

= Eseguire un test funzionale
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o Tipi di dato
o Chiavi primarie ed esterne

o Vincoli di integrita

2. Installazione di Postgres e PostGIS, Setup dell'Ambiente di Lavoro e
Creazione Tabelle
Obiettivi:

« Installare PostgreSQL e PostGIS

» Configurare un ambiente di lavoro

» Creare lo schema di tabelle secondo specifiche

» Eseguire un test funzionale
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2.3 Creazione Tabelle:
= Creazione tabelle tramite pgAdmin esempio
» Creazione tabelle tramite script SQL derivati dallo schema relazionale:
CREATE TABLE poligono popolazione (
Id_poligono SERIAL PRIMARY KEY,
geom GEOMETRY{Polygon, 4326),
N_popolazione INT,

Data_valutazione DATE

15

2.4 Test Funzionale:
* Inserimento dati di test tramite script S0L:
INSERT INTO poligono_popolazione (geom, n_popolazione, data_valutazione)
VALUES (
ST_SetSRID{

ST_GeomFromText{'POLYGON(( 1250000 5700000, 1251000 5700000, 1251000
5701000, 1250000 5701000, 1250000 5700000 })'), 3857),

1250,
2025-05-07
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3. Installazione di Tomcat e GeoServer

Obiettivi:
» Installare Java, Tomcat e Geoserver
« Verificarne il funzionamento
= Connettere Geoserver a PostGIS

* Creare un layer su Geoserver

3.1 Scarica Apache Tomcat:
- Vai al sito ufficiale di Apache Tomcat: https://tomcat.apache.org/download-90.cgi
- Seleziona la versione di Tomcat 9.x, che & compatibile con GeoServer.

- Scarica il tile ZIP per Windows o tar.gz per Linux/mac05.

3.2 Estrai Tomcat:

- Windows: Estrai il file ZIP in una cartella, ad esempio C:\tomcat.

3.3 Verifica il funzionamento di Tomcat:
- Windows: Esegui startup.bat in C:\tomcat\bin.
- Linux/macOS: Esegui ./startup.sh nella cartella bin.

- Visita http://localhost:8080 nel browser.
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- Seleziona la versione di Tomcat 9.x, che e compatibile con GeoServer.

- Scarica il file ZIP per Windows o tar.gz per Linux/macOS.

3.2 Estrai Tomcat:
- Windows: Estrai il file ZIP in una cartella, ad esempio C:\tomcat.

3.3 Verifica il funzionamento di Tomcat:
- Windows: Esegui startup.bat in C:\tomcat\bin.
- Linux/macOS: Esegui ./startup.sh nella cartella bin.

- Visita http://localhost: 8080 nel browser.

3.4 Installazione di GeoServer su Tomecat:
1. Scarica GeoServer da https://geoserver.org/download/
2. Copia il file geoserver.war nella cartella webapps di Tomcat.

3. Avvia Tomcat e accedi a http://localhost:B08B0/geoserver

3.5 Connessione di GeoServer a PostGIS:
- Login: admin / geoserver
- Menu Data > Stores > Add new Store > PostGIS

- Configura parametri (host, porta, database, username, password)

- Salva e pubblica layer
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- Windows: Estrai il file ZIP in una cartella, ad esempio C:\tomcat.

3.3 Verifica il funzionamento di Tomcat:

- Windows: Esegui startup.bat in C:\tomcat\bin.

- Linux/macO5s: Esegui ./startup.sh nella cartella bin,

- Visita http:/flocalhost: 8080 nel browser.

3.4 Installazione di GeoServer su Tomcat:
1. Scarica GeoServer da http == ke e £ adf
| [ : = [

2. Copia il file geoserver.war nena cartena ﬁ._renapﬁs_én Tomcat.

3. Avvia Tomcat e accedi a http://localhost:8080/geoserver

3.5 Connessione di GeoServer a PostGIS:
- Login: admin / geoserver
- Menu Data > Stores > Add new Store > PostGIS
- Configura parametri (host, porta, database, username, password)

- Salva e pubblica layer
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3.2 Estrai Tomcat:

- Windows: Estrai il file ZIP in una cartella, ad esempio C\tomcat.

3.3 Verifica il funzionamento di Tomcat:

- Windows: Esegui startup.bat in C:\tomcat\bin.

- Linux/macOS: Esegui ./startup.sh nella cartella bin.

- Visita http://localhost:8080 nel browser.

3.4 Installazione di GeoServer su Tomcat:
1. Scarica GeoServer da https://geoserver.org/download/
2. Copia il file geoserver.war nella cartella webapps di Tomcat.

3. Avvia Tomcat e accedi a http://localhost:B080/geoserver

3.5 Connessione di GeoServer a PostGIS:
- Login: admin / geoserver
- Menu Data > Stores > Add new 5tore > PostGI5S
- Configura parametri (host, porta, database, username, password)

- 5alva e pubblica layer
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« Creazione tabelle tramite script SQL derivati dallo schema relazionale:
CREATE TABLE poligono_popolazione (
Id_poligono SERIAL PRIMARY KEY,

geom GEOMETRY(Polygon, 4326),

N_popolazione INT,

Data valutazione DATE

li

2.4 Test Funzionale:
* [nserimento dati di test tramite script SOL:
INSERT INTO poligono_popelazione {(geom, n_popolazione, data_valutazione)
VALUES (
5T_SetSRID|

ST_GeomFromText('POLYGON(( 1250000 5700000, 1251000 5700000, 1251000
5701000, 1250000 5701000, 1250000 5700000 )J'), 3857),

1250,
2025-05-07
)
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» Creazione tabelle tramite script SQL derivati dallo schema relazionale;
CREATE TABLE poligono_popolazione (
Id_poligono SERIAL PRIMARY KEY,
geom GEOMETRY(Polygon, 4326),
N_popolazione INT,

Data_valutazione DATE

)i

2.4 Test Funzionale:
» Inserimento dati di test tramite script SQL:
INSERT INTO poligono_popelazione {(geom, n_popolazione, data_valutazione)

WALUES (

ST GeomFromText('POLYGOMN(( 1250000 5700000, 1251000 5700000, 1251000

5701000, 1250000 5701000, 1250000 5700000 })'), 3857),
1250,
'2025-05-07"'

);
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3.6 Definizione Layer in GeoServer:

- Layers > Add a new Layer
- Seleziona tabella (es. areeverdi), configura SRS EP5G:3857, stile, bounding box
- Pubblica

3.7 Verifica la visualizzazione tramite WMS/WEF5:

- Apertura con Openlayer da Geoserver

- Verifica corretta visualizzazione

4 Verifica competenze acquisite:

https://docs.google.com/forms/d/e/1FAIpQLSe6fSizelrA-DNYivR2j94-
xks6hCCRQlgBtOQRa6ZkIuBNThw/viewform fusp=dialog
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Titola

Training on the Job - Modulo 1
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione

dell'Infrastruttura DB
Oblettivi:

» Comprendere |a struttura logica dei dati
= Definire le entita, relazioni e attributi
* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database
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- Modulo 2 - Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Obiettivi

* Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
GeoPackape, PostGlS, ecc.)
Importare ed integrare layver "verdi” [es. aree verdi) e "blu” (es. aree blu) nel database
spaziale
Garantire corretto sistema di riferimento [SRS/EPSG) e metadata

Comprendere quali aree verdi si importeranno
Fasi operative

Analisl preliminare dei dati
- Verifica formati disponibili: .shp/.dbf/.shx, GeoPackage, connessioni
0GR/ Geo]50N
Controllo SRS e bounding box
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Modulo 2 - Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Oblettivi

* Comprendere formati e strutture dei dati vettoriali georeferenziati [Shapetfile,

GeoPackage, PostGlS, ecc.)

Importare ed integrare layer "verdi” [es. aree verdi) e "blu” [(es. aree blu] nel database
spaziale

Garantire corretto sistema di riferimento [SRS/EPSG) e metadata

Comprendere quali aree verdi si importeranno
Fasi operative

Analisi preliminare det dati
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Titolo

Training on the Job - Modulo 2
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

« Modulo 2 - Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Obiettivi
+ Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
GeoPackage, PostGlS, ecc.)

* [Importare ed integrare layer "verdi” (es. aree verdi) e "blu” (es. aree blu) nel database
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Training on the Job - Modulo 2 Impo

Modulo 2 — Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Obiettivi

* Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
GeoPackage, PostGlS, ecc.)
Importare ed integrare layer "verdi” (es. aree verdi) e “blu” (es. aree blu) nel database
spaziale
Garantire corretto sistema di riferimento [SR5/EP5G) e metadata

Comprendere quali aree verdi si importeranno
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Training on the Job - Modulo 2
Importazione de

Modulo 2 - Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Obiettivi

s Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
GeoPackage, PostGlS, ecc.)
Importare ed integrare layer "verdi” [es. aree verdi) e "blu” [es. aree blu) nel database
spaziale

Garantire corretto sistema di riferimento [SRS/EPSG) e metadata




Titolo

b

Training on the Job - Modulo 1
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione

dell'Infrastruttura DB
Obiettivi:

» Comprendere |a struttura logica dei dati
» Definire le entita, relazioni e attributi
* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:

1. Analisi dei requisiti informativi del progetto
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Training on the Job - Modulo 2
Importazione dei dati da

Modulo 2 - Importazione dei dati da file Shapefile o altri DB
georeferenziati

Durata prevista: 1,5 giornate

Obiettivi

* Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapetile,
GeoPackage, PostGlS, ecc.)
Importare ed integrare layer "verdi” [(es. aree verdi) e "blu” {es. aree blu} nel database

spaziale

Garantire corretto sistema di riferimento [SRS/EPSG) e metadata
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Titolo

Training on the Job - Modulo 2
Importazione dei dati da file Shapefile o
altri DB georeferenziati

« Modulo 2 — Importazione dei dati da file Shapefile o altri DB

georeferenziati

Durata prevista: 1,5 giornate

Obiettivi

+ Comprendere formati e strutture dei dati vettoriali georeferenziati {Shapefile,
GeoPackage, PostGls, ecc.)

¢ Importare ed integrare layer "verdi” (es. aree verdi) e "blu” (es. aree blu) nel database
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Training on the Job - Modulo 2
Importazione dei dati da file Shapefile o
altri DB georeferenziati

Durata prevista: 1,5 giornate
p .

Obiettivi

+ Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
GeoPackage, PostGlS, ecc.)
Importare ed integrare layer “verdi” [es. aree verdi) e "blu” (es. aree blu) nel database
spaziale

# Garantire corretto sistema di riferimento [SRS/EPSG) e metadata

* Comprendere quali aree verdi si importeranno
Fasi operative

Analisi preliminare dei dati

- Verifica formati disponibili: .shp/.dbl/.shx, GeoPackage, connessioni
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Training on the Job - Modulo 2
Importazione dei dati da file Shapefile o
altri DB georeferenziati

Durata prevista: 1,5 giornate

Obiettivi
= Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,

GeoPackage, PostGlS, ecc.)
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1. Analisi dei requisiti informativi del progetto
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1 Fase |B giornate)

Definizione del diagramma E/R e delle specifiche relative per la creazione
dell’infrastruttura DB (1 giornata) - in sede ISPRA (gia realizzata)

2. Installazione di PostGlS, defimzione di un ambiente di lavoro, creazione delle
tabelle ritenute necessane per il progetto. Test funzionale. (1/2 giornata)

3. Installazione di Geoserver, definizione dei laver e integrazione delle tabelle. Test
tunzionale. (1/2 glomata)

4. Importazione det dat da file Shape o altri db georeferenziat per la costruzione
degh elementi verdi ¢ blu (1 e ¥ giornate)

5. Importazione dei dati della popolazione su raster formito da ISPRA (1 e '
glomate)

6. Installazione ambiente di lavoro usando Eclipse, defimizione classi per accesso
DB (2 giornate)

7. Confronto su sviluppo del geodatabase - (1 giornata) - in sede ISPRA

2 fase |24 giornate)

1. Calcolo der punt di ingresso delle aree verdi ¢ blu (4 giornate)

2, Calcolo della distanza minima fra 1 centroidi dei poligoni rappresentanti la
popolazione e 1 punti di ingresso delle aree verdi e blu (2 giornate)

3. Stesura del codice per la visualizzazione degh elementi su mappa georeferenziata
interattiva (10 gromate)

4. Confronto su attivita di sviluppo parte client — (2 giomate) — in sede ISPRA
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Titolo

ba

1 Fase |8 piornate)

Definizione s AZIODE
dell”infrastry

Installazion@ S - hone delle
tabelle riteng P . l1ata)
Installazione 2= i tabelle. Test
funzionale, o

Importazion iy rostruzione

degh clementr verdr e biu (1 e % giornare)

Importazione der dati della popolazione su raster formito da ISPRA (1 e 1%
giomate)

Installazione ambiente di lavoro usando Eclipse, defimzione classi per accesso
DB (2 giornate)

Confronto su sviluppo del geodatabase - (1 giornata) - in sede ISPRA

2 Tase (24 giornate)

Calcolo der punti di ingresso delle aree verdi ¢ blu (4 giornate)

Calcolo della distanza minima fra 1 centroidi dei poligoni rappresentanti la
popolazione e 1 punti di ingresso delle aree verdi e blu (2 giornate)

Stesura del codice per la visualizzazione degli elementi su mappa georeferenziata
interattiva (10 giorate)

Confronto su attivita di sviluppo parte client — (2 giomate) — in sede ISP
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1 Fase (B piornate)

Definizione del diagramma E/R e delle specifiche relative per la creazione
dell"infrastruttura DB (1 giornata) — in sede ISPRA (214 realizzata)
Installazione di PostGIS, defimizione di un ambiente di lavoro, creazione delle
tabelle ritenute necessarie per il progetto. Test funzionale. (1/2 giornata)
Installazione di Geoserver, definizione dei laver ¢ integrazione delle tabelle. Test
funzionale. (1/2 giomata)

Importazione dei dat da file Shape o aliri db georeferenziat per la costruzione
degh elementi verdi e blu (1 e 'z giornate)

Importazione dei dati della popolazione su raster fornito da ISPRA (1 e 14
glomate)

[nstallazione ambiente di lavoro usando Echipse, defimizione classi per accesso
DB (2 giornate)

Confronto su sviluppo del geodatabase - (1 giornata) - in sede ISPRA

2 fase (24 glornate)

Calcolo der punin di ingresso delle aree verdi ¢ blu (4 giornate)

Calcolo della distanza minima fra 1 centroidi dei poligom rappresentanti la
popolazione e 1 punti di ingresso delle aree verdi e blu (2 giornate)

Stesura del codice per la visualizzazione deghi elementi su mappa georeferenziata
interattiva (10 grorate)

Confronto su attivita di sviluppo parte client — (2 giornate) — 1n sede ISPRA
Sviluppo maschere per esportazione dati su formati definiti nella fase di analisi (2

glormate)
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Training on the Job - Modulo 2
Importazione dei dati da file Shapefile o
altri DB georeferenziati

Durata prevista: 1,5 giorpate

Obiettivi
= Comprendere formati e strutture ded dati vettoriall georeferenziati (Shapefile,
GeaPackapge, PostGIS, ecc.)

importare ed integrare layver “verdi” [es. aree verdi) e "blu” (es. aree blu) nel database
spaziale

Garantire corretto sistema di riferimenta [5R5 G) & metadata

Comprendere quali aree verdi si importeranno
Fasl operative

Analizi praliminare dat dati
- Verifica formati disponibili: shp/.dbf) shy, GeoPackage, connessionl
OGR MGea] SOMN
Controllo SRS @ bounding box
Controllo dei poligoni in particolare dell’attributo area, ubicazione e tipologia
delle AR JOMPLESSE [aree verci con all'interno albert) @ diet TAPPETI
ERBOSI [prati con eventualmente alberi recensiti)
Identificazione attributi rilevanti {es. Tipologia, area, codice 1D, ubicaziona)

e blu” in PostiGls

Aggiunta di indici spaziali [GIST che sta per Generalized Search Tree. E un tipo di

indice Nessibile che PoztgreS0L usa per diversi tipl di dati, inclusi | dat spaziali
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Importazione dei dati da file Shapefile o
altri DB georeferenziati

Drurata prevista: 1.5 giornate

Obiettivi
= Compreéndere formati e strotture ded dati vettorali georelerenziat [Shapolile,
GeoPackage, PostGIS,

Importaire ed integrare layer “verdi” [es5. aree verdi) e “blu”™ (es. aree blu) nel database
spaziale

Garantire corretto sistema di riferimento [SRS/EPSG) e metadata

Comprendere quali aree verdi si importeranno
Fasi operative

Analisi preliminare dei dati
Verifica formati disponibili: shp/.dblf shx, GeoPackage, connessioni
OGRMGea]SON
Contralle SRS e hounding box
Coantrollo dei poligont in particolare dell’sttributo area, ubleagione e tipologia
delle AREE COMPLESSE [aree verdi con all’interno alberi) e dei TAPPETI
ERBOSI [prati con eventualmente alberi recensit )

[dentificazione attributi rilevantl (es. Tipologta, area. codice 1D, ubicazione)

Evéntuale modihica dello schema DB dr destinafiansg

- Definizione schema “aree_verdl”™ e “aree_blu” in PostGlS

Aggiunta di indici spaziall [GIST che sta per Generalized Search Tree. E un tipo di

indice Nessibile che PostgreSQL usa per divers tipi di dati, inclusi i dati spaziali
[Reometrie come punti, inee, poligoni, ecc.])

https: !/ postgis.net,workshop ostgis-introfindexing.html
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altri DB georeferenziati
Durata prevista: 1.5 giornate
Dbiettiv
# Comprendere formati e strutture dei dati vettoriali georeferenziati (Shapefile,
Geolackage, PostGIS, ecc.)
Importare ed integrare layer “verdi” (es. aree verdi) e "blu” (es. aree blu) nel database
spaziale
Garantire corretto gistema di riferimento I_EH!'i.,-"I".!?f':'ti_I o rmetadats
Comprendere guall aree verdi si importeranno
Fasi operative
nare del dat
ifica formati disponibili: shpf.dbi/ shx, GeoPackage, connessioni
AL 3L
- Controllo SRS @ bounding box
Controllo dei poligeni in particolare dell’attributo area, ubicaziene ¢ tipologia
L COMPLESSE [arec verdi con all’'interno alberd) @ dei TAPPETI
ERBOSI (pratl con eventualmente albert recensit)
Identificazione attributi rilevanti [es. Tipologia, area, codice 1D, ubicazione)
niodifica di
Definizione schema “aree_verdi™ ¢ "aree_blu” in PostGIS
Aggiunta di indici spaziali (GIST che sta per Generalized Search Tree E un tipo di
cie Nessibile che Postgre50QL usa per diversi tipi di dati, inclusi | dati spaziall
[geometrie come punti, linee, poligoni, ecc.j)
hity postgisnet fworkshops, postgis-introSindexing. homl
Impartazione doti
- Usodi shp2pgsql per esportare shp in script 5QL
Dreee @ B B B - -
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Comprendere formati @ strutture ded datl vettoriall georeferenziatl [(Shapefile,
GeaPackage, Post |
Importare e integrare ].,|I1,'|_'-r “werdi® | W i:-||,|| el databa
spaziale

Garantire corretto sistema i riferimento

Comprendere quali aree verdi si importeranno
Fasi operative

Analigi prelir o dal
- Verifica formati disponthili: shp/dbi/ shx, GeoPackage, connes
OGR fMGeo] SON
Controllo 5RS ¢ bounding box
Controllo dei poligoni in particolare dell"attributo area, ubicazione e tipologia
delle AREE COMPLESSE [aree verdi con all'interno alberd) ¢ del TAPPETI
ERBOSI (pran con eventualmente alberi recensiti)
ldentificazione attributi rilevanti (es. Tipologin, area, codice 10, ubicazione)

hen dakle

Definizionm ema "aree_verdi” ¢ "aree_bhi” in PostGlS

Aggiunta di indici spaziali (GIST che sta per Generalized Search Tree. E un tipo di

inedice Me ile che l"llh!}!:‘l:ﬂ-[}l. (FEH WRiL divers [ di datd, inelust | datd 5 all
[gecmetrie come punti, linee, poligoni, ece.))

https stgis.net fworkshops/postgis-intro/indexing. html

Uzo di shp2pgsql per esportare shp in script SQL
Verifica inserimento ¢ proi
Ripetizione per layer “hlu”
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Sttivi
Comprendere formati @ strutture dei dati vertoriali georeferenziati (Shapefile,
GeoPackage, PostGIS, ecc.)
Importare ed integrare layer “verdi” [es. aree verdi] e “blu” [es. aree Blu) nel database
zlale
Garantire corretto sistema di fiferimento [SRESFEPSG) e metadata

Comprendere gquali aree verdi s1 importeranno

5| operative

gliminare dei dat
Verifica formati disponibiliz shp/fdbly she, GeoPackage. connessioni
OGR/Geo)50N
Controllo SRS @ bounding box
Cantrolla ded polEgan in pa riicolare dell atrriboato area, uhicazione: e |1;1|:!-|-Ilj.:i-l
delle AR OMPLESSE [aree verdi con all'interno alberi] e dei TAPPETI
ERBOSI [prati con eventualmente alberi recensiti]

ldentifcazione attributi rlevantl [es. 'l'l[mllu;l..l., area, codios 10, whik Azione)

Apglunta di indici spaziali (GIST che sta per Generalized Search Tree. Eun tipa di

indice Nessibile che PostgreSQL usa per diversi tipi di dati, inclusi | dogi spaziali
[geometrie come puntd, linee, poligoni, ecc.))
https vorkshops,/postgis-intro/indexing. html
fione gat
Uza ol shpZpgsgl per e rtare shp in script SQL
Verifica inserimento ¢ projezions
Ripetizione per layver "blu®

Mostrare entrambe le modalitd possibili di importazione:

Metodo A - tramite “Esporta”
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Comprendere formati e strutture dei dati vetboriali georeferenziati (Shapefile, -
GeaPackage, PostGlS, ecc.)
linportare | infegrare ].l:.- aF “vardil”™ (e aree ".'1.=r'|.|lj & “hlu” | 5. aree bilii) nel databaze
spaziale
Garantire corretto sistema di fferimento |HI-!‘.'3..-'I'.']’.‘1TI'| i metadata
Comprendere guall aree verd| si importeranno
Fasi operative
Analit preliminare det dat
nbrollo deld poligeni in particolare dell’attributo area, ubicazione e 1
delle AREE COMPL aree verdl con all'interno alberi) & del TAPP
ERBOSI [prad con eventualmente alberi recensil)
[dentificazione attributi rilevanti {es, Tipologia, area, ¢ ¢ | D), ubicazione)
Eventuale modifica dello schema 08 di destinazion
Definizione schema "aree_verdi™ e "aree_blu®™ in Py
Aggiunta di indicl spaziall (GIST che sta per Gerera arch Tree, E un tipo df
indice MNessibile che PogtgreS0L usa per divers] tipl di dati, inclusi i dati spaziali
[geometrie come punti, linee, poligoni, ecc.j)
https:/ / postgis.net/workshops /postgis-intro/indexing.homi
Iimportarions dati
Lzo di shp2pgsgl per esportare shp in seript SOL
Verifica inserimento e projeziones
Mostrare entrambe le modalits possibili di importazione
Metodo A - tramite "Esporta”
Fai clic destro sul layer che vuol importare {es. uno shapefile|
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SPAETAI
s Garantire corretio sistema di riferimento [SRS/E e metadata
®  Comprendere quali aree verdi si importeranno
Fasl operative
Anmlis
rifica Formati |||'1"|1|'||1||1|'|:| ‘-IL[FI-".El.I:brI.'. i, reoPa i@, Conmme
OGR fGeo] 50N
Controllo & bhounding box
Contrallo ded poligont in particolare dell®amributo area, uhicazione e tipologia
delle AREE COMPLESSE [aree verdl all'interno alberi) ¢ dei TAPPETI
ERBOSI (prati con eventualmente alben recensiti)
ldentifcazione attributd rilevanii | Tipologia, area, codice 10, ubicazione)
Gls
Aggiunta di indici spaziali (GIST che sta per Generalized Search Tree. E un tipo di
indice Nessibile che PostgreS0QL usa per divers] tipi di dati, inclusi i datl spaziali
[Eeametrie come pnti, T N F‘”IU-'-"“"' [ir=l ||
https ostgisnet workshops,/postgis-intro/indexing . html
Importanone deb
Uzo di shp2pg=ql per esportare shp in script SQL
Varifica inserimento ¢ projezions
Ripetizione per layer “hiu”®
Mostrare entrambe le modalita possibili di importazione
Metodo A - tramite "Esporta”
Fai clic destro sul layer che vuol importare [es uno shapefile)
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Contrallo SRS e bounding bo
rollo del poligeni in particolare dell’attributo area, ubicazione ¢ tipologia
delle AREE COMPLESSE [aree verdi con all'interno alberi) e dei TAPPETI
ERBOSI [prati con eventualmente alberi recensiti)
ldentificazione attribut rilevant jes, Tipologia, area. codice 1D, 'II|:FII'.I'.-:I1:|III."
g modifica s schema D8 di destinaziona
Definizione schema “aree_verdl”™ e "aree_blu”™ in PostGIlS
Aggiunta di indict spaziall (GIST che sta per Generalized Search Tree, Eun tipa di
indice Nessibile che PostgreSQL usa per diversi tipi di dati, inclusi i doti spaziali
[geometrie come punti, linee, poligoni, ece.))
https: / / postgis.net / workshops/postgis-introfindexing. html
tane doti
Uso di shp2pgsql per espoartare shp in script SQL
Verifica inserimento e proiezione
Ripetizione per layer "hlu®
Mostrare entrambe le modalita possibili di importazione:
Metodo A - tramite “Esporta”
Fai clic destro sul layer che vuoi importare [es. uno shapefile)
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importazions dati
Uzo di shp2pgsgl per esportare shp in script SQL
Verifica inserimento e proiezione
Ripetizione per layer “hiu”

Mostrare entrambe le modalita possibili di importazione

Metodo A = tramite "Esporta”
Fai elie destro sul J:|:|.'|,-r el vuo importare [ %, uno ~i|1.'||14,=|i||-}

Seleziona "Esporta” = "Salva elementi come..."

Melly inestra apre:

Formato: scegli PostgreSOL

Database: seleziona la connessione PostGlS creata prima

Nome tabella: scegli il nome da dare alla tabella nel DB

SRID: assicurati che sia corretio [es 43260 857 1

Premi OK

QGIS esporters tutti | campi e le geometrie, ¢ creera automaticamente la taballa
im Fostlls

Metodo B - tramite DB Manager
Wi su Dkptabase = DE Manager
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Verifica inserimento e proiezione
Ripetizione per layver "blu®

Mostrare entrambe le modalita possibili di importazione:

Metodo A - tramite "Esporta”
Fai clic destro sul layer che vuoi importare (es. uno shapefile)

Seleriona "Esporta” = “Salva elementi come...”

Mella finestra che si apre:

Farmato: scegli PostgreS0L

Database: seleziona la connestione PostGls ereaata prima

Nome tabella: scegli il nome da dare alla tabella nel DB

SRID: assicurati che sia corretto (es 4326 0 3857

Premi OK

QGI%S esportera with | campl e le geometrie, ¢ creera automaticamente la tabelia

in FostGls

Metodo B - tramite DB Manager

Vai su Database = DB Manager

Mella sexione di sinistra, trova il tuo database PostGlS
Clicea su "Importa Layer™

Scegli il lnyer QGIS da importare
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Seleziona "Esporta” = "Salva elementi come..”
Mella Nnestra che <4 apre;
Formato; scegll PostgreSOL
Database: seleziona la conne tG1S creata prima
Mome tabella: s li il nome da dare alla tabella nel DB

SRID: assicurati che sia corretio (es. 4326 o 3857

Premi OK

QGIS esportera tutti | campi e le geometrie, & creera automaticamente la tabella

in PostGl5.

Metodo B = tramite DE Manager

Val su Database = DB Manager

Mella sexltone di simistra, trova | tuo database PostGlS
Clicea su "lmporta Layer™

Scegli il layer QGIS da importare

Configura;

Momie tabella

SRID

Se creare indice spaziale

e sovrascrivere tabelle esistentd
Fremi OK

FROM public.aree verdi;

Nel caso si dovesse calcolare gli attributi come densita_alberi:
Importazione & degli shapefile ALBERD & TAPPETI.

Tramite attributo [comune alle due abelle) ubicazione andiamo a prendere i
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Seleziona "Esporta” = "Salva clementi come..”

Mella i ra che i apre;

Formuato: -"'-"'Hh I-‘::-hlgrvl';lﬁl_ﬂ.

Database: seleziona la connessione PastiGlSs creata prima

Nome tabella: scegli il nome da dare alla tabella nel DB

SRID: assicurati che sia corretio (es. 4326 o 3857

Premi OK

QGIS esportera tutti i campi e le geometrie, ¢ creera automaticamente la tabella
in PostGls.

Metodo B = tramite DE Manager
Val su Database = DB Manager
Mella sexione di sinistra, trova | tuo database PostGls
Clicca su "lmporta Layer”

Scegli il layer QGIS da importare
Configura;

Mome tabella

SRID

Se creare indice spaziale

Se sovrascrivere tabelle esistenti
Fremi 0K

Successivamente verificare lNimportazione:
SELECT *
FROM public.ares_verdi:

Mel caso si dovesse calcolare gli attributi come densita_alberi:
Importazione ¢ degli shapefile ALBERD & TAPPETILL

Tramite attributo [comune alle due tabelle) ubicazione andiamo a préndere i
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Configura:
Mome tabella
SRID

crears indice =

FROM pubilic.aree werdi;

Mel caso gi do e caleolare gli attributi come densita_alberi:
Importazione ¢ degli shapetile ALEERD ¢ TAPPETL
Tramite attributo (comune alle due tabelle) ublcazione andiamo a prendere i
poligoni & i punti.
Con la funzione 5T Withing punt, |m|i|.:unn:| =TRUE
SELECT
aubicazione, —campo ubicazione dell’area

COUNT [c.*) AS numero_alberl, —Campo caleale numers di alberl totale

ST _Areala.geom) AS area_mdg, --Lampo area = |:||,|||;|.;|||1-::- ares verde

ROUMD (COUNT (%) f ST _Arcafageom), 2) AS densita_alberi_mg, --Campa

caleolo densith alberi
FROM aree a
LEFT JOIN alberi t ON 5T_Contains{a.geom, tgeom)

GROUP BY a.id_area, a.geom;
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FROM public.ares_verndi; g

= Mel caso si dovesse calcolare gli attributi come densita_alberi:
Importazione e degli shapefile ALBERO e TAPPETI.
Tramive attributo (comune alle due tabelle) ubicazione andiamo a prendere |
paligoni e i punti.
Con la funzione §T_Within{punto, poligono] = TRUE
SELECT
..I.IJ]1:II:'it:-'.III11E'_ ==LalklT] M3 IJ11:II.'|I:-'.IIII1l' Ill_'lllull'il"il.'
COUNT [£.°) AS numero_alberi, —Campo calcolo numere di alberi totale
5T _Areala.geom) AS area_ma, —~Campo area del poligono area verde
ROUND (COUNT (%] f 5T_Arcan.geom), 2] AS densita_alber|_mg, --Campao
calcolo densita alberi
FROM ared o
LEFT JOIM alberi t ON 5T _Containsa.geom, t.geom)
GROUP BY a5d_ares, agoeom;

Aggiungere Density = Numers di alberi f Superficie
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FROM publicares_verdi;

Wel caso si dovesse caloolare gli attributi come densita_alberi:
Importazione e degli shapefile ALBERD e TAPPETI.
Tramite attributo [comune alle due abelle) ubicazione andiamo a prendere §
paligoni & i punti.
Con la funzione 5T_Within{punto, poligono] = TRUE
SELECT
aubicaziones, —c IV M0 ubicazione dell'area
COUNT [t.°) AS numero_alber), —-Campo calcolo numeroe di alberi totale
5T .l".n::u:.q.ﬁ'.umul AS area_myg, ~-Campo area del poligono ares verde
ROUND [COUNT (] f 5T _Arcas.geom), 2] AS densita_alber|_mg, --Campo
calcolo densitd alberi
FROM ared
LEFT JOIN alberi t ON 5T _Contains|a.geom, tgeom)
GROUP BY aucl_ared, agoeom;

Aggiungere Densita = Numers di alberi / Superficie
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Aggiungere Densitd = Numere di alberi / Superficie

cgimun imserire | dati da una tabella ad un'altra:

Verifica & puliZia post-importaiione
- Query di controlle (SELECT COUNT, bounding box)
= Correzione geometrie invalidi con ST_MakeValid
Aggiunta di metadati: data import, fonte
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Mella sezione di sinistra, trova il tuo database PostGls
Clicca su "Impaorta Layer”

Scegli il layer QGIS da importare

Configura:

MNome tabella

SRID

Se creare indice spaziale

se sovrascrivere tabelle esistenti

Premi OK

Successivamente verificare I'importazione:
SELECT *
FROM public.aree_wverdi;

MNel caso si dovesse calcolare gli attributi come densitd_alberi:
Importazione e degli shapefile ALBEERO e TAPPETI.
Tramite attributo [comune alle due tabelle) ubicazione andiamo a prendere i
poligoni e | punti.
Con la funzione ST_Within{punto, poligono) = TRUE
SELECT
a.ubicazione, --campo ubicazione dell’area
COUNT (r.*) AS numero_alberi, --Campo calcolo numero di alberi totale
ST_Area[a.geom] AS area_mq, --Campo area del poligono area verde
ROUND [COUNT (r.*) / ST_Area(a.geom), 2) AS densita_alberi_mg, --Campo
calcolo densita alberi
FROM aree a
LEFT JOIN alberi t ON 5T _Contains(a.geom, Lgeom)
GROUP BY a.id_area, a.geom;
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- Controllo dei poligond in particolare dell"attributo area, ubicazione e tipologia
delle AREE COMPLESSE [aree verdi con all'interno alberi) e del TAPPETI
ERBOSI [prati con eventualmente alberi recensiti)

Identificazione attributi rilevanti (es. Tipologia, area, codice 1D, ubicazione)

rntuale modifica dello schema DB di destinazione
- Definizione schema "aree_verdi” e "aree_blu” in PostGIS
- Aggiunta di Indici spaziali (GIST che sta per Generalized Search Tree. E un tipo di
indice flessibile che PostgreSQL usa per diversl tipi di dati, inclusi | dati spaziall
[geometrie come punti, linee, poligoni, ecc.})
https:/ fpostgis.net /'workshopsfpostgis-intro/indexing html

Importazione dat
- lUso di shp2pgsql per esportare .shp in script 5QL
- Verifica inserimento e projezione
- Ripetizione per layer "blu®

Mostrare entrambe le modalitd possibili di importazione:

Metodo A = tramite "Esporta”

Fal clic destro sul laver che vuoi importare (es. uno shapefile)
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Titolo

Training on the Job - Modulo 1
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione

dell'Infrastruttura DB
Obiettivi:

» Comprendere |a struttura logica dei dati
» Definire le entita, relazioni e attributi
* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database

=quisiti informativi del progetto
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1 Fase |8 glornate)

Defimzione del diagramma E/R ¢ delle speciiiche relative per la creazione
dell’mfrastruttura DB (] giornata) — in sede ISPRA (gid realizzata)

Installazione di PostGlS, definizione di un ambiente di lavoro, creazione delle
tabelle ritenute necessarie per il progetto. Test funzionale. (1/2 giornata)
Installazione di Geoserver, definizione dei layer e integrazione delle tabelle. Test
funzionale. (1/2 giornata)

Importazione dei dati da file Shape o altn db georeferenziati per la costruzione
degh elementi verdi e blu (1 e ': giomate)

Importazione dei dati della popolazione su raster fornito da ISPRA (1 e 2
giornate )

Installazione ambiente di lavoro usando Eclipse, defimzione classi per accesso
DB (2 gornate)

Confronto su sviluppo del geodatabase - (1 giornata) - in sede ISPRA

| 24 Frornate)

Calcolo dei punti di ingresso delle aree verd: e blu (4 giornate)

Calcolo della distanza minima fra i centroidi dei poligoni rappresentanti la
popolazione e 1 punti di ingresso delle aree verdi ¢ blu (2 giornate)

stesura del codice per la visualizzazione degli element su mappa georeferenziata
mterattiva (10 giornate)

Confronto su attivita di sviluppo parte chient - (2 giornate) — in sede ISPRA
Sviluppo maschere per esportazione dati su format definiti nella fase di analiss (2
giomate)

sviluppo codice per la creazione di grahici/tabelle (2 giornate)

Verifica funzionale del progetto di formazione (1 giornata) — in sede ISPRA

Test delle competenze acquisite (1 giornata) - eventualmente in sede ISPRA




il = a w

] = B

F-

Lt snfmrel 10 e sy

-
-1 1 !
el
i
i Telf M Lepdy
g EE 3
il










Liks

S e



Enlasi (prasis | ¥

Module 4 — Installazione ambiente di lavoro con Eclipse + Jersey + Tomcat

+ Postgresql
Durata prevista: 2 giornate

Obiettivi
«  Configurare un progetto Java Web in Eclipse usando |ersey come framework REST
* Gestire manualmente le librerie necessarie (Jersey, PostgreSQL, GeoTools)
* Sviluppare le classi di accesso al database e i servizi REST

» [Esporre servizi RESTIul per interagire con dati spaziali
Fasi operative

Instatlazione & configurazione Eclipse
- Scaricare e installare Eclipse IDE for Enterprise Java and Web Developers
- [mpostare Java JDK (11 consigliato, compatibile con |ersey 3.x)
Vai su: Window > Preferences > Java > Installed JREs
Clicca su Add..., s a Standard VM e clicca Next
Inserisci il percorso della JDK (es. c: /Program Files/Java/jdk-17
Dai un nome (es. Java 17) e clicca Finish
Seleziona il JDK appena aggiunto come predefinito

Creare un nuovo Dynamic Web Project in Eclipse:
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Modulo 4 — Installazione ambiente di lavore con Eclipse + Jersey + Tomcat
+ Postgresql
Durata prevista: 2 giornate
Ohiettivi
« Configurare un progetto Java Web in Eclipse usando Jersey come framework REST
¢« Gestire manualmente le librerie necessarie [Jersey, PostgreSQL, GeaTools)
¢«  Sviluppare le classi di accesso al database e i servizi REST
« [Esporre servizi RESTful per interagire con dati spaziali
Fasi operative
+ Installazione & con
Scaricare e installare Eclipse IDE for Enterprise Java and Weh Developers
Impostare Java DK (11 consigliato, compatibile con Jersey 3.x)
Vai su: Window Preferences Java Installed
Clicea su Add.... seleziona Standard VM e clice
Inserisci il percorso della JDK (es. ©: /Program
Dai un nome (es. Java 17) e clicea Findsh
Seleziona il JDK appena aggunto come predelinito
Creare un nuovo Dynamic Web Project in Eclipse:
Un Dynamic Web Project in Eclipse & una struttura progettuale pensata per lo
sviluppo di applicazioni web Java (serviet, |SP, APl REST). Consente di generare
contenuti dinamici gestit da un server apphicativo come Tomcal,
Hiee W 0 W -
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Crea Server:

Click destro nella spazio bianco > New > Server

Seleziona Tomeat v9.0 Server e specifica la cartella di installazione di

Tomcat

Premi Finish

# Trascina il tuwo progetto nel server o clic destro su Tomcat > Add and
Remove...

Seleziona il tuo progetto

Clic su Add > Finish

Aggiunta manuale delle librerie

- Scaricare | JAR di Jersey, |DBC PostgreSQL e GeoTools

- hitps://eclipse-gedjgithubio/jersey.github.io/download. htm]
Lidbepostgresqlorg/download/

feourceforee net/projects fpeotools/

Inserire | JAR In WebContent/WEB-1NF /lib/

- Verificare che | |AR siano referenziati nel build path del progetto

Configurazione web,.xml
- Definizione serviet JerseyREST

- Assoclazione URL-pattern fapi/*




R R —— | :‘ ¥ Alpmen dgmls  VANESE] | Pl g - e o e B o

[ T I R T T T T e

T"tl.Jlr_l‘ Lajan foary Ealisi [pragis |

LI5S " AR

Creazione dei package & classi
- Ad esempio:
com.progetto.ispra.db; gestione connessione DB PostgreSQL/PostGIS
com.progetto.dspradan: classi dao
com.progettodspramodel: classi dio e enkity
com.progetto isprarest: classi REST
com.progetio.ispraservice: classi service
Esempio di connessione al DB

Classe DEConnectionManager con |DBC DriverManager

Esempio REST AP| con lersey
= [mplementazione classe AreaResource con metodi GET e POST
- Uso di Med peAPPLICATION_|SON e Response

Deploy e test

- Deploy del progetto su Tomcat

= Testcon Postman o browser
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Titolo

Training on the Job - Modulo 1
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione

dell Infrastruttura DB
Obiettivi:
» Comprendere la struttura logica dei dati
» Definire le entita, relazioni e attributi
* Produrre un diagramma E/R coerente con i requisiti del progetto

» Redigere specifiche tecniche per la realizzazione fisica del database
Attivita previste:
1. Analisi dei requisiti informativi del progetto



Titolo

ne

Training on the Job - Modulo 1
Gestione Database e Pubblicazione
Geospaziale con PostGIS e GeoServer

1. Definizione del Diagramma E/R e Specifiche per la Creazione
dell'Infrastruttura DB
Obiettivi:

* Comprendere la struttura logica dei dati

» Definire le entita, relazioni e attributi

* Produrre un diagramma EfR coerente con i requisiti del progetto

* Redigere specifiche tecniche per la realizzazione fisica del database

Attivita previste:

1. Analisi dei requisiti informativi del progetto
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== Sicurezza di Windows

Le credenziali specificate non funzionano

L'amministratore del sistema non consente l'utilizzo di credenziali !'Iﬂl;]ﬁl.huﬂ!i
salvate per I'accesso al computer remoto TOT) perché l'identita di & UILLTES LA

tale computer non e stata completamente verificata. Immettere le
nuove credenziali. - =

Administrator

Password

-Illlll'llll"l-l

apache-to... IMSET\administrator

Tentativo di accesso non riuscito
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!;. Connessione Desktop remoto X

=L ] LT O
| rt} Impossibile verificare dentita del computer remoto.
W%/ Connettersi comunque ?
[ | Impossibile autenticane | computer remoto 3 causa di problemi con § relalivo @
L certificalo di sicurezza. Potrebbe essere rischioso continuare

Nome cedificato

- - l MNome nel cerficato del computer remoto o LTS LA A
101
— 1=

Emon certificab . —_— =

Durante la convalida del certificato del computer remoto si sono
verficati gh emon seguenti:

I [ cerificato proviene da una Autorita di cerificazione non
disponibile nell'elenco locale .

k.

‘I.'l
Eseguire la connessione nonostante gli emor dei cerdificali?
apache-to..

; Non visualizzare piu questo messaggio per le connessioni a quesio
- computer

. Visuakizza certiicato 2 No
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« Sviluppare le classi di accesso al database e i servizi REST
« Esporre servizi RESTful per interagire con dati spaziali

Fasi operative

Installazione e configurazione Eclipse
- Scaricare e installare Eclipse IDE for Enterprise Java and Web Developers
- Iernstare Java |JDK (11 consigliato, compatibile con Jersey 3.x)

e Val su: Window > Preferences > Java > Installed JREs

» Clicca su Add.... seleziona Standard VM e clicca Next

e Inserisci il percorso della JDK (es. c: /Program Files/Java/jdk-17)
e Dail un nome (es. Java 17) e clicca Finish

e Seleziona il JDK appena aggiunto come predefinito

Creare un nuovo Dynamic Web Project in Eclipse:

Un Dynamic Web Project in Eclipse & una struttura progettuale pensata per lo
sviluppo di applicazioni web Java (servlet, |SP, API REST). Consente di generare
contenuti dinamici gestiti da un server applicativo come Tomcat.
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